
Instructions for converting pinball to virtual reality. 

 

This tutorial is a simple conversion of a EM-table into the VR environment. 

 

I.e. the normal table is supplemented by a VR room with clock and - if available – a flyer. 

Furthermore, the table is placed in a cabinet. The artwork of the cabinet and the backbox is initially 

generic; i.e. the same for all tables. If you want to have the correct artwork, you can easily create it 

yourself. But more about that later. 

 

Furthermore, animations of the buttons (plunger, flipper buttons, start button, magnasave buttons) 

are built into the tables. 

 

The change of the brightness and the color design is possible by the 15 LUT files. 

 

My concern was, to make a conversion as easy as possible for all users, since playing a normal table 

in VR - that is, in a completely black room - is not fun, at least for me. So I hope, that in the future 

some people will pick themselves up and at least do this quick conversion and upload the tables; if 

they have the authorization for it 😉. 

 

A lot of the things I'm describing are optional (written in italics) to this. But even if everything is 

integrated, you should be able to do a conversion in 15 minutes (if you've done some conversions). 

If one finds and uses the special artwork of the cabinet, probably another 15 minutes or so will be 

added to make the graphics. 

 

I focused on the Loserman76 tables for now, since there are a lot of them, almost all are relatively 

identical and have the same table size (Gottlieb). Should you use other manufacturers, you can also 

take already manufactured VR conversions at hand and use the cabinets of these tables. 

 

In the download you will find the materials and images you need, as well as the template for the 

Gottlieb tables. There are also PSD files available, to change the graphics for the cabinet etc. 

 

And now enough of the preface. Let's get started! 

 

Procedure: 

 1. Download the template 

 2. Open the table to be converted in the editor 

 3. Import the materials 

 4. Import of the graphics 

 5. Open the template table in the same editor (do not open a new editor) 

 6. Create layers in the table to be converted (optional) 

 7. Copy and paste the objects 

 8. Creating collections 

 9. Inserting the lines in the script 

 

 

 

 



Download the template 

The file contains the VR table, the materials and the graphics. 

I always copy and unzip the file to the folder of the table I want to convert. But you can put it 

anywhere and unzip it. 

Download 

Opening the table, to be converted in the editor 

Load the table, you want to convert into the editor. If you are still using older versions, take the latest 

ones from here: 

10.7.2: https://github.com/vpinball/vpinball/releases/tag/v10.7.2-366-f94da1e 

(Log in to Github to download the version) 

10.8.0: https://github.com/vpinball/vpinball/actions/workflows/vpinball.yml 

(Log in to Github, click on last workflow and download 32bit version) 

 

Importing the materials 

Open the Material Manager with F4 or via the menu and import the file "_VR_Materials.mat" from 

the template folder. 

 

 
 

 

https://mega.nz/file/QF8ymBgI#j_XJ2eCA2eNQ7BMEEVq3fFGhV4x6CXCH4paeVV0zvEc
https://mega.nz/file/QF8ymBgI#j_XJ2eCA2eNQ7BMEEVq3fFGhV4x6CXCH4paeVV0zvEc
https://github.com/vpinball/vpinball/releases/tag/v10.7.2-366-f94da1e
https://github.com/vpinball/vpinball/actions/workflows/vpinball.yml


Then close the window again with "OK". 

 

Importing the graphics 

Open the Image Manager with F3 or via the menu. Then import all image files from the template 

folder. If you do not want to use the flyer, you can deselect it here. 

 

 

(Optional) 

Now you have the possibility to change graphics for the Cabinet, the Backbox or the Flyer. To do this, 

click on one of the entries Flyer1, VR_Back_UV_Map or VR_Cab_UV_Map in the Image Manager. 

When you have selected the entry, click on the "Reimport From" button in the menu on the right and 

confirm, that you want to change the graphic. 

Select your new graphic for the respective entry and after a few seconds it will be displayed. 

Then close the window with "OK". 

 

(Optional) 

Importing the sounds 

When you change the LUT files, you will hear a sound, also when you reach the end of the choices 

(gun.wav). You can import the sound in the Sound Manager (F2). 

 

After the Sound Manager (F2) has opened, click on "Import", select the sound from the template 

folder and then close the window again. 



 

 

(Optional) 

Changing some settings for the table 

I always change some settings for the table. If you want to do the same, do it as follows. 

To do this, click in the editor, without selecting an object. Then you should see "Table1" in the right 

pane. Click on the tab "User", if it should not be active. 

Check "Night->Day cycle" and set the slider to position 2. 

 

Click on the "Visuals" tab, if it should not be active. 

I always use my own ball. It’s a little bit brighter and better to see, when the table is dark. To do this, 

make the following settings. Of course, you can also use your own ball. To do this, you must also 

import it in the Image Manager. 

 

 

Click on the "Lights" tab, if it should not be active.  

 

Click on "Light Emission Color" and then click on  

the white square. The following values are now applied. 

 
Then set the values shown in the image and select 

"VR_Roomenvironment" from the drop-down box. 

 

Loserman76 has a ramp in many tables, that is too large and can be seen outside the table in VR. So 

far, this has always been the "Ramp19". If you want, to find the object quickly, enter the name in the 

layer area and confirm. After that the ramp should be displayed.  

If you double-click on the entry, it will be highlighted. Now you can change the width of the ramp in 

the upper section "Properties". The playfield normally has a width of 952 for the tables. Click on the 

tab "Visuals" and enter 952 for "Top With" and "Bottom With". 

 
Furthermore, in almost every table there is the "Wall78". This also 

protrudes from the cabinet. To make a change here, you have to 

mark the two red marked points on the top left and bottom left. This 

is sometimes difficult, because the timers are in the way and are 

marked. Mark the timers and move them away. When you have 

clicked on the first red marker, hold down the Shift key and click on 

the second point. Then, using the left arrow key, you can move the 



points to the right so that they are in the Cabinet area. If you hold down the shift key, the movement 

will be faster. 

Open the template table in the same editor (do not open a new editor). 

In the opened editor, use the "Open" menu, to load the Template-Table „! VRRoom Template 

(Gottlieb) 10.7.2“. If you are using a wedge head table, select the template. In this case the backbox 

is different. Then you have to use other graphics from the template folder. 

 

 

After that, you will see the two loaded tables in the "Window" menu item and can switch between 

them. 

If you see an asterisk behind a table name, it means, that there are unsaved changes in the table. 

 

 
 

You should now be in the template table. If this is not the case, please select it. In the right area of 

the editor you can see the properties of the table and the objects. Below that is the area for the 

layers. 

At least that's how it should look. Unfortunately this area - especially the one for the layers - has a lot 

of bugs. So you should save your work every now and then. 

The procedure I describe is only one of many. But it has been shown, that mostly no bugs occur. Also 

you don't have to create special layers for each area - like I did. 

  
 

First, double-click on the "VR Room and Cabinet" layer. After a few seconds you will see in the editor 

that all objects are marked (selected) in blue. Don't click in the editor window now, because this will 

deselect the objects or select only the one you clicked on. 

Select "Copy" in the Edit menu.  

 



 
Now switch to the table, to be converted via Window in the menu. As soon as this table appears, 

press STRG+V (CTRL+V) or "Paste" in the Edit menu. This will paste all VR objects and they will 

remain selected. 

Since we have already selected all objects, we immediately create a new collection for them. Either 

you call the Collection Manager via the Table menu or - easier - press F8. 

When the Collection Manager is open, click on "Create from selection". A new collection with the 

name "Collection001" will be created. Change this name to "ColRoomMinimal". If you use another 

name, you have to change it in the script as well. So just use the name. Then it fits with the script. 

 
While we are in the Collection Manager, we can delete the collection "DesktopCrap". It’s not longer 

necessary. 

Optional 

The objects of the VR environment should still be selected. Again, don't click in the editor window, but 

in the layer area click on the small plus symbol. This will add a new layer. It doesn't matter, how you 

name it. I always use the name from the template table. 

Click with the mouse into the field, if the name is marked blue. When you have entered the name, 

don't use the return key to end the input, just click with the mouse on the entry.  

Depending on what was done before, it happens from time to time, that the layer area hangs up and 

no more editing is possible. Then the only thing that helps, is saving the table, closing VPX and 

reopening the table. 

The objects should still be selected and the new layer as well. Now click on the small icon in the layer 

area in the upper left corner. This will add the selected objects to this layer and you can make them 

visible or hide them by setting the checkmark in front of the layer name. 

 

 

 



 
 

Now we do the same with the VR timers. You switch to the template table, double click on "VR 

Timer", copy the four marked timers, switch to the other table and insert them 

Optional 

Create a new layer, rename it if necessary and add the timers to this layer. 

The last layer to be added is the Backdrop layer. Here only the LUTBox is located in the template 

table. This shows in desktop mode which LUT has been selected. 

Switch back to the template table and click on the symbol for "Backglass View" in the left area of the 

editor. 

 

 
 

There is only one object in it. Select it and copy it. Switch to the other table. "BackglassView" is 

already open there. Now insert the LUTBox with STRG+V (CTRL+V). 

Probably there are much more objects in the view. All existing objects should now be stored in a 

separate collection. 

Draw a rectangle around all objects with the mouse. After that they are marked blue. 

 



 
 

Since all objects are still selected, you call the Collection Manager again with F8, click again on 

"Create from selection" and give the collection the name "ColBackdrop". 

Again the hint: If you choose another name, you have to change it later in the script. 

Optional 

Now you can create another layer for these objects. I create it and name it "Backdrop". 

 

There are still three objects in the Loserman76 tables, that need to be hidden in VR, which are not in 

the backglass view. These are usually "Ramp3", "Ramp4" and "Ramp17", sometimes "Ramp2", 

"Ramp8" and "Ramp17". 

The objects are the left and right rails and the lockdownbar. 

These must be added to the collection "ColBackdrop". 

Start the Collection Manager again with F8, doubleclick on the collection "ColBackdrop". 

Search for the ramps in the left window and mark them. Then move them to the right window with 

the button, click "OK" and close the manager. 

Now we come to the... 

 

Inserting the lines in the script 

To make it easier, I always put both script windows next to each other. 



So open the first table and click on the Script Editor.  

 

 

Then switch to the other table and open the script editor there as well. 

Places both windows next to each other.  

 

 
Marks the first subsection and copies it (VRRoom); line 1 - 20. I copy also the green lines, even if they 

have no function. 

Now look for Sub Table1_Init in the converted table. This is usually located after all the dim 

commands in the Loserman76 tables. 

In front of this sub you insert the copied lines. 

Since you now see the Table1_init area, you can also delete the script lines at the beginning of the 

sub, since they are no longer needed. If you do not do this, you will get an error at startup because 

the collection has been deleted. 

 If Table1.ShowDT = false then 

  For each obj in DesktopCrap 

   obj.visible=False 

  next 

 End If 

Now look for the Sub Table1_exit in the converted table. Here you will find commands, that are 

called, when you exit the table. Add the command 



saveLUT 

The spelling or where the command is in the sub, does not matter.  

 

 

Now look for the sub Table1_KeyDown(ByVal keycode). In Loserman’s tables this is normally also 

directly under the sub Table1_exit. In this and the sub Table1_KeyUp(ByVal keycode) the control of 

the buttons etc. is regulated. 

Selects and copies the lines 35 - 78 from the template table and inserts them after the beginning of 

the sub Table1_KeyDown(ByVal keycode) in the converted table. 

Marks and copies the lines 84 - 106 from the template table and inserts them after the beginning of 

the sub Table1_KeyUp(ByVal keycode) in the converted table. 

Finally, mark and copy lines 110 to the end of the script. Then switch to the converted table, scroll to 

the end of the script and insert the lines there. 

In the last two subs (saveLUT and loadLUT), at the very end of the script, there are three lines with 

the name under which the table saves the last called LUT. You have to change these three names. 

It does not matter how you assign the name. It only has to be identical in all three lines. 

 

Note: The lines preceded by ' in the script are comments, which are only there for explanation. Of 

course you can - if you want - delete these lines. It is also possible, to insert some sections 

somewhere else without disturbing VPX. I got into the habit of doing it this way, because it is easier 

and I know, where to find the partial areas faster. 

This completes the conversion. You should now save again in any case. 

After that you can start the table and see if there are any errors.  

If errors occur or objects are visible, that should not be visible on the desktop or in VR, this may be 

because, they are not available in the respective collection or because there are still calls somewhere 

in the script and the objects are therefore not hidden. Then these lines in the script must also be 

searched for and changed.  

If something does not work, please let me know. Maybe we can solve the problem together. 



Also, I would appreciate if you send suggestions for improvement of this tutorial. I realize that the 

tutorial has become quite extensive. However, the actual conversion is quick. I had to go into a bit 

more detail, since not everyone is familiar with the editor. 

 

Rajo Joey, v1.5 (long), 07.03.2023 


